
1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 271. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

1. FAOSTYLE FOR ENGLISH 2017 3 1.1  About FAOSTYLE 3 1.2  Updated English FAOSTYLE 

3 1.3  Who should use FAOSTYLE? 3 1.4  Contact 3 2. SPELLING AND PUNCTUATION 4 

2.1  Spelling and readability 4 2.2  Punctuation 4 3. TERMINOLOGY AND NAMES 7 3.1  

Terminology 7 3.2  Names 7 3.3  Foreign languages 9 3.4  Language resources 10 3.5 Gender-neutral language 

10 4. LISTS 10 5. ABBREVIATIONS AND ACRONYMS 11 6. CAPITALIZATION 12 7. 

ITALICS 13 8. NUMBERS, UNITS, TIME AND DATES 14 8.1 Numbers 14 8.2 Units 15 8.3 Percentages 15 8.4 Dates 

15 8.5 Time 16 8.6 Currencies 16 8.7 Mathematics and equations 16 9. QUOTATIONS 17 10. CITATIONS AND 

REFERENCING STYLE IN FAO PUBLICATIONS 17 10.1 General indications 17 10.2 

Reference lists and bibliographies 18 10.3 Examples of bibliographic style 21  ANNEX 1 INSTALLING 
REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE 27

FAOSTYLE
2017 / English

(INCLUDES GUIDANCE ON CITATIONS TOOL  
FOR USE WITH REFERENCE MANAGEMENT SOFTWARE)

JUNE 2017



The designations employed and the presentation of material in this 
information product do not imply the expression of any opinion 
whatsoever on the part of the Food and Agriculture Organization 
of the United Nations (FAO) concerning the legal or development 
status of any country, territory, city or area or of its authorities, 
or concerning the delimitation of its frontiers or boundaries. The 
mention of specific companies or products of manufacturers, 
whether or not these have been patented, does not imply that 
these have been endorsed or recommended by FAO in preference 
to others of a similar nature that are not mentioned. The views 
expressed in this information product are those of the author(s) and 
do not necessarily reflect the views or policies of FAO. 
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“I think the following rules will cover most cases: 

i. Never use a metaphor, simile, or other figure of speech 
which you are used to seeing in print.

ii. Never use a long word where a short one will do.
iii. If it is possible to cut a word out, always cut it out.
iv. Never use the passive where you can use the active.
v. Never use a foreign phrase, a scientific word, or a jargon 

word if you can think of an everyday English equivalent.
vi. Break any of these rules sooner than say anything outright 

barbarous.”

George Orwell, Politics and the English Language
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1. FAOSTYLE FOR ENGLISH 2017

1.1 ___ ABOUT FAOSTYLE 
The objective in having a house style is to ensure clarity and consistency across all FAO publications. 
Therefore, the rules and conventions specified in FAOSTYLE must be applied in all FAO publications.

FAO provides editorial style guides in its six official languages (Arabic, Chinese, English, French, 
Russian and Spanish) to ensure consistency and quality across its information products. The Library and 
Publications Branch (OCCP), with the support of the Meeting Programming and Documentation Service 
(CPAM), reviews the guides periodically to reflect developments in general usage, editorial conventions, 
translation, publishing practices and editing tools. 

The editorial style guides cover matters such as punctuation, units, spelling and citations. Common issues 
are explained in all languages, but each version of FAOSTYLE also covers problems specific to the 
language concerned. 

The guides serve as a reference for all FAO information products, including public information materials, 
as well as for correspondence. 

1.2 ___ UPDATED ENGLISH FAOSTYLE

This updated version of FAOSTYLE for English is intentionally brief and limited in scope. The overall aim 
is to simplify some aspects of the writing/editing process that until now have required a disproportionate 
amount of time, e.g. following idiosyncratic spelling rules, and having to generate reference entries in a 
form that does not facilitate the use of reference management software. Re the latter, this guide presents 
an FAO bibliographic style in Citation Style Language (CSL) for use with Mendeley and Zotero. 

For more complete coverage of aspects of publications (e.g. content development, writing, editing, 
graphic design and marketing), please refer to Publishing at FAO – strategy and guidance (forthcoming). 
For other editing issues not addressed in this FAOSTYLE or Publishing at FAO, please refer to the Oxford 
English Dictionary, the Chicago Manual of Style,1 and the United Nations Editorial Manual.

1.3 ___ WHO SHOULD USE FAOSTYLE?
All FAO staff, consultants and contractors involved in writing, reviewing, editing, translating or 
proofreading FAO texts and information products should refer to FAOSTYLE. Use of FAOSTYLE should be 
included in the terms of reference (TOR) for all authoring, translation, editorial and proofreading contracts.

1.4 ___ CONTACT
If you have any comments or queries, please contact PWS-support@fao.org

1  This link works for staff at FAO headquarters in Rome. Those working in decentralized offices can access the site via the  
 FAO Secure Access Gateway.

https://en.oxforddictionaries.com/
https://en.oxforddictionaries.com/
http://www.chicagomanualofstyle.org/home.html
http://dd.dgacm.org/editorialmanual/
mailto:PWS-support@fao.org
https://home.fao.org/dana-na/auth/url_default/welcome.cgi
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FAOSTYLE 2017 – ENGLISH

2. SPELLING AND PUNCTUATION

2.1 ___ SPELLING AND READABILITY
For spelling and usage, follow the first spelling listed in the latest online edition of the Oxford English 
Dictionary. The FAO Recommended Word List is discontinued.

Aim for consistency. Where alternative spellings and terms are available, ensure that the usage is 
consistent within a work. Pay particular attention to this issue in multi-authored texts.

When using word processing software, e.g. Microsoft Word, ensure that the default language for your 
document is set to English (United Kingdom) by selecting Review – Language – Set Proofing Language in 
the toolbar. 

Remember: computer spellcheckers are a useful tool but not sufficient by themselves. 

Reading aloud a printed copy of your document is a good way to spot spelling, punctuation and 
grammar errors. This technique can also improve its readability. If you run out of breath or have difficulty 
reading a sentence, then it is probably too long or complex. Remember that English will not be the first 
language for many readers. Sentences of more than 20 words are difficult for many people, so be 
concise, also to facilitate scan reading online.

You can also check the readability of your document by using the Flesch Reading Ease and 
Flesch–Kincaid Grade Level tools available in Word (Options – Proofing – Show Readability Statistics).

2.2 ___ PUNCTUATION
Punctuation is important because it can help improve clarity and readability. The following is a brief 
clarification of FAO usage with regard to commas, full stops, etc. For other punctuation matters, follow the 
indications in the online version of the the Chicago Manual of Style.

— Commas
Do not use a comma:

• after i.e. and e.g.

• before opening parentheses.

Do not use a comma before and in short lists, e.g. sheep, goats and oxen. However, a comma may be 
used in lists to avoid ambiguity, e.g. The unit was responsible for overall management, research and 
development, and marketing, or where a sentence comprises a complex series of phrases, e.g. Ensure 
that the participants receive the training material in advance, have time to prepare their responses, 
and have access to relevant resources.

— Full stops
Use full stops:

• with a.m., p.m., e.g. and i.e. 

• in abbreviations such as ed., et al., Inc., No., p., pp., Vol.

https://en.oxforddictionaries.com/
https://en.oxforddictionaries.com/
http://www.chicagomanualofstyle.org/home.html
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Do not use full stops: 

• after people’s titles and qualifications, e.g. Mr, Mrs, Ms, Dr, MSc and PhD

• in initialisms and acronyms, e.g. FAO, ILO, GDP

• after abbreviations of units of measurement, e.g. 12 kg, 30 m

• after a heading or figure, table and box titles 

• in contractions, where the last letter is the same as that of the original word, e.g. Ltd (Limited),  
  as well as plural contractions, e.g. eds (editors), vols (volumes) 

• after website addresses.

— En-dashes
An en-dash (–) is longer than a hyphen (-) and can be used either in pairs to set off an element that is not 
part of the main sentence, or alone to add a phrase elaborating on what has gone before. 

FAO does not use the em-dash (—).

To obtain the correct en-dash, press CTRL+MINUS on the numeric keypad (or ALT+MINUS on Macintosh) 
or select the en-dash from under Insert – Symbol. Do not use double hyphens to denote an en-dash.

Paired, parenthetical dashes have a space on either side: e.g. Poverty in rural areas – home to 
94 percent of the poor – has been reduced at a slower rate. They should not be overused (only once 
per paragraph).

An unspaced en-dash is used between words of equal weight (Paris–Rome flight) and for relationships 
(pupil–teacher ratio) when the first part of a compound does not modify the second part. 

• pp. 1–20 (range of values) 

• 1987–1993; 2011–15

• cost–benefit analysis 

• dose–response curve 

• rice–fish farming

• South–South cooperation 

• see also Section 8.4 Dates

Do not use the en-dash to denote a range of values or dates with the constructions from ... to or between 
... and, e.g. from 1970 to 1987, not from 1970–1987.

— Hyphens
For general usage, consult the Hyphens section in the Oxford English Dictionary (OED) Online.  
Also useful is a ten-page hyphenation guide (available as a PDF) in The Chicago Manual of Style Online 
section 7.85 (available as a PDF at www.chicagomanualofstyle.org/16/images/ch07_tab01.pdf).

 2. SPELLING AND PUNCTUATION

https://en.oxforddictionaries.com/punctuation/hyphen
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Notes and examples:

• Turn off the automatic hyphenation function. In Word 2013, select Page Layout, Hyphenation, 
None. (Note: At layout stage, you may need to adjust the automatic hyphenation setting in 
InDesign, especially for pages with several columns of text.)

• For nouns, use the first spelling given in the OED Online, e.g. cooperation rather than co-
operation. 

• Use a non-breaking space (Alt/Ctrl+Shift+Space) or a non-breaking hyphen (Alt/
Ctrl+Shift+Minus) to avoid ending a line of text with a hyphen.

• With proper nouns, use upper case for all principal hyphenated words, e.g. European 
Commission for the Control of Foot-and-Mouth Disease. 

• Never use hyphens to break names of people or places at the end of the page or anywhere in 
the text unless if the hyphen is part of the name, e.g. Victoria not Vic-toria.

• Never use two hyphens together, instead use the en-dash.

• Many compound adjectives should be hyphenated, e.g. sugar-free, results-driven, cost-effective. 

• Use of well: the problem was well known, but a well-known problem. 

• Plan for the long term, but long-term planning.

• No hyphen after “-ly”: a radically changed situation.

• Use hyphens for clarity when describing ages, numbers and lengths of time. Compare: 
15-year-old fish (fish that are 15 years old) with 15 year-old fish (15 fish that are all one year old). 

• A USD 5000-investment; a three-year plan.

• Separate a prefix from a date, e.g. pre-2000.

• Numeric plurals in a list, e.g. two-, three- or fourfold.

• No hyphen in phrasal verbs: food reserves began to build up. 

• Director-General; Assistant Director-General.

Position of note numbers
For footnotes and endnotes, use sequential numbering and not other characters or symbols. The note 
numbering is one sequence for the entire main text (not by chapter). Begin numbering again for each 
annex/appendix. The note number (in superscript) should be placed at the end of the sentence after the 
terminal punctuation. 

• This is an example.1

Where used within a sentence, it should go at the end of the clause after the punctuation. 

• The process failed to respect the standard procedure,2 which explains the extreme values. 

The general rule is to place the note number after punctuation. The exception is with an en-dash, where 
the number comes after the word before the en-dash3 – as shown here.
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3. TERMINOLOGY AND NAMES

3.1 ___ TERMINOLOGY

— Terminological resources
The TERM PORTAL has been created to store, manage and update concepts, terms and definitions 
related to the various topics of FAO (agricultural sciences, nutrition, biotechnology, fisheries, forestry, 
food security, to name a few) in all FAO official languages (plus Italian and Latin for taxonomies). Among 
the various collections, it includes FAOTERM, which is the oldest terminological collection, and the FAO 
Structure and the Names of Countries database (NOCS).

For guidance on UN terminology and other aspects of style, refer to the United Nations Editorial 
Manual.

— Basic information about FAO
The full title of FAO is the Food and Agriculture Organization of the United Nations (FAO). The 
abbreviated form is FAO, not preceded by “the” and without dots (not F.A.O.), e.g. in 1951, FAO 
moved its headquarters to Rome. 

Note that the acronym FAO, when used, is placed at the end of the full name, not after Organization. 
Other common mistakes to avoid are the substitution of Agricultural and Organisation. The abbreviation 
of the full title to FAO of the UN is tolerated for some media purposes, but should otherwise be avoided. 

Only when referring to FAO should the word organization take a capital letter, e.g. the Organization has 
regional offices around the globe.

Write an FAO regulation (not a FAO ...).

The FAO Conference, after it has been mentioned in full, may subsequently be referred to as the 
Conference (with a capital letter). 

FAO headquarters does not take a capital h. Do not use the initialism HQ.

3.2 ___ NAMES

— Country names and other toponyms
FAO has 197 Members comprising 194 Member Nations, one Member Organization (European 
Union) and two Associate Members (Faroe Islands and Tokelau). Use the FAO Names of Countries 
database (NOCS) to check names of countries and territories. The database stores also the currencies 
and the country codes. The designations used in the system are based on UN practice and may differ 
from popular use. 

It is important to use the correct names for countries. For most purposes and publications, use the “short” 
name as shown in NOCS, even though this may sometimes appear long to you. The NOCS “full” names 
tend to be used in very formal documents such as agreements and at official ceremonies. 

http://www.fao.org/faoterm/en/
http://termportal.fao.org/faonocs/appl/
http://dd.dgacm.org/editorialmanual/
http://dd.dgacm.org/editorialmanual/
http://termportal.fao.org/faonocs/appl/
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Names in NOCS are updated as necessary, for example, most recently:

• 20 February 2017, Change of name: The long name of the former Islamic Republic of the 
Gambia has changed back to the Republic of the Gambia since 17 February 2017. The short 
name does not change.

• 30 August 2016, Czechia: The short name of the Czech Republic has changed from 17 May 
2016.

Use TERM PORTAL for abbreviations and acronyms, as well as for names of organizations and 
specific technical terms.

Pay attention to sensitive political issues. Use caution statements and FAO’s standard disclaimers. 

Maps may be controversial and must be checked carefully before publication. Ensure any names are 
correct (for country names, check NOCS). Do not simply reproduce maps provided by other sources. 
Various countries may have unresolved or competing claims on land and maritime areas. Consult the 
UN Cartographic Database.

— Official names of countries and organizations
Countries such as the Netherlands and the United States of America are collective singular nouns and 
thus always take singular verbs.

Country names should be fully spelled out when used in the noun form: the United States of America. 
ISO country codes should only be used to abbreviate countries in figures: USA.

Particular attention should be made to the following countries for which the designation must be carefully 
followed:

FULL NAME SHORT NAME SHORT NAME FOR LISTS AND TABLES

the Plurinational State of Bolivia Bolivia (Plurinational State of) Bolivia (Plurinational State of)

the Republic of the Congo the Congo Congo

the Democratic Republic of the Congo the Democratic Republic of the Congo Democratic Republic of the Congo

the Islamic Republic of Iran Iran (Islamic Republic of) Iran (Islamic Republic of)

The former Yugoslav Republic of 
Macedonia

The former Yugoslav Republic of 
Macedonia

The former Yugoslav Republic of 
Macedonia

the United Arab Emirates the United Arab Emirates United Arab Emirates

the United Republic of Tanzania the United Republic of Tanzania United Republic of Tanzania

the United States of America the United States of America United States of America

the Bolivarian Republic of Venezuela Venezuela (Bolivarian Republic of) Venezuela (Bolivarian Republic of)

The European Union (Member Organization) is a Member of FAO. Where it is included in discourse, as 
it is not a nation, country or state, it is more correct to speak of FAO Members (with a capital M) rather 
than Member Nations, Member Countries or Member States. In NOCS, the full and short forms, also for 
tables, are the same: European Union (Member Organization). Hence, in text, refer to it as the European 
Union (Member Organization). Do not abbreviate it to the EU in text, although expressions such as EU28 

http://www.fao.org/faoterm/en/
http://intranet.fao.org/departments/occ/publishing/guidelines/production2/disclnotices/
http://www.un.org/Depts/Cartographic/english/htmain.htm
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and EU25 are acceptable in text and tables if their meaning is clarified. Instead of EU legislation, prefer 
legislation of the European Union.

The Holy See, not the Vatican, has Permanent Observer status at FAO.

Use Near East rather than Middle East unless the latter is specifically required.

— Titles and proper names
Follow individuals’ expressed preference on how to mention their names. As the surname is the first 
element in certain nationalities’ names, the order should not be inverted. Note that Spanish and 
Portuguese names often include two surnames. 

It is generally not necessary to use honorifics or titles, such as Mr, Mrs, Ms, Sir, Professor and Dr. In 
general, people should be referred to by their names, not their titles.

Alphabetization of names (for reference sections and indexes):

• Chinese and Vietnamese names: alphabetize according to the first (family) name, e.g. Kim 
Thanh, C.

• Arabic names: the particles Al and El are not taken into account when ordering reference lists 
and indexes, e.g. Al-Hamadan is listed under H and not under A.

• Burmese names: move the honorific (U, Naw, Saw) to the end before alphabetizing.

• Spanish surnames: where there are two surnames, alphabetize according to the first surname 
(e.g. Ángel Martinez Espinosa is listed under Martinez Espinosa).

• Portuguese names: where there are two or more surnames, the entry is usually alphabetized 
according to the last surname. Words like Filho, Junior, Neto, Netto, Sobrinho are treated as part 
of the last surname: Paulino Ricardo do Rosario Gomes Filho is indexed as Gomes Filho. 
Note: José Graziano da Silva is listed under G. 

• The particles van, de, etc. are taken into account for the alphabetical ordering of the list, e.g. 
de María is listed under D and not under M.

— Scientific names
Use italics (see also Section 7. Italics) to indicate genera, species and subspecies (e.g. Oryza sativa, 
Cucurbita spp.), but not for higher levels of taxonomic classification (e.g. Brassicaceae). Note that 
modifiers to species’ names (e.g. cv., var., spp.) and species authorities (e.g. Rubus L.) are not italicized.

Besides TERM PORTAL, see also the International Plant Protection Convention style guide. 

3.3 ___ FOREIGN LANGUAGES

— Foreign words and phrases
Foreign words and phrases that have become anglicized should be in normal font (not italicized), e.g. ad 
hoc, a priori, de facto, de jure (see also Section 7. Italics). 

Avoid giving a quote or word directly in a foreign language. If it is absolutely necessary, make sure it is 
clear, and provide a translation in parentheses.

3. TERMINOLOGY AND NAMES

http://www.fao.org/faoterm/en/
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Use official translations of titles of publications, major events, organizations and so on. Where no official 
translation exists, a translation may be made.

When reproducing foreign words, include the diacritical marks that are placed above or beneath certain 
letters and which change their sound.

— Foreign titles and proper names
Foreign proper nouns, people’s names and the names of currencies are not italicized.

— Transliteration 
Only translate and transliterate Cyrillic, Arabic, Chinese or other scripts into Latin characters when no 
official translation exists. 

3.4 ___ LANGUAGE RESOURCES 
Besides TERM PORTAL, the following language resources and links are provided as a support to all 
those who are involved in the research of language equivalents and validation of terms and titles for 
authoring, translating, revising and editing information products: 

• AGROVOC – The FAO Thesaurus serves as a controlled vocabulary for the indexing of 
publications in agricultural science and technology.

• FAO Biotechnology Glossary

• IATE – The terminology database of the European Union

• UNTERM – The United Nations terminology database

• International Plant Protection Convention style guide. 

3.5 ___ GENDER-NEUTRAL LANGUAGE
FAO seeks to use gender-neutral language. For example, rather than fishermen, use fishers (like farmers); 
prefer chairperson or chair to chairman; prefer humanity or humankind to mankind; prefer human-induced 
or caused by humans to man-made; prefer labour, personnel and workforce to manpower.

4. LISTS
Lists are generally punctuated in the same way as sentences, with semicolons or full stops at the end of 
each item in the list. No punctuation is necessary in lists with very short entries.

Available audiovisual equipment includes:

• radios 

• televisions 

• cameras.

When list entries are complex but not complete sentences, use initial lowercase letters at the start of the 
phrase and end each with a semicolon, except for the final entry, which ends with a full stop.

http://www.fao.org/faoterm/en/
http://aims.fao.org/aos/agrovoc/
http://www.fao.org/biotech/biotech-glossary/en/
http://iate.europa.eu/SearchByQueryLoad.do;jsessionid=q6bGWwLLmhFNw1pHvnHnwhkTxg18n1s0wWTrZQ1p4gl1dyNhH3NQ!260031356?method=load
https://unterm.un.org/UNTERM/portal/welcome
https://www.ippc.int/en/publications/132/
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4. LISTS

The process will consist of:

• extensive beta testing followed by a review process;

• re-engineering of the software based on pilot-group feedback and peer review; and 

• a second phase of testing followed by final modifications, approval and rollout.

When entries consist of complete sentences, begin each with a capital letter and end each with a full stop.

• The necessary equipment should be requested from suppliers.

• All staff should provide a budget code for each request.

• All equipment should be accounted for.

Use numbered lists when a specific sequence is dictated, to facilitate subsequent cross-referencing, 
e.g. see point 12, or because the preceding text makes specific mention of a ranking or number of 
entries, e.g. There are 15 reasons why you should offer your support. 

Be consistent throughout the document. Use the same types of bullet points and the same numerical and 
letter series for the same levels of information. Do not mix numbers and bullets in sublists. 

Unless they need to appear in a ranking or chronological sequence, country names should be given in 
alphabetical order in text, lists and figures. 

5. ABBREVIATIONS AND ACRONYMS
Abbreviations (short forms of words, e.g. Mrs, Dr, Vol.) and acronyms/initialisms (initial letters of words, 
e.g. GDP) should be used where they improve readability, but do not litter the text with them.

In documents intended for external target audiences, do not use acronyms that are only used within the 
Organization, e.g. for divisions, offices and units.

Use the TERM PORTAL to check acronyms or refer to an original source if the acronym is not 
included there.

Acronyms should always be defined in full the first time they are used in a document: e.g. the World 
Health Organization (WHO). They may then be used alone, e.g. According to a WHO spokesperson 
... If parts of a publication are likely to be read separately (such as front matter and body text, or 
independent chapters), consider spelling out the acronym upon first mention in each of the parts concerned.

Avoid the use of acronyms in the titles and level headings of publications.

Acronyms and initialisms do not take full stops (e.g. FAO, not F.A.O.); most abbreviations do (e.g. min.), 
with the exception of units of measurement (kg, ml) and contractions. See also Section 2.2 Full stops. 

Avoid overuse of the abbreviations e.g., i.e. and etc. in the main text. These can be replaced with that 
is, in other words, for example, such as and so on. They are acceptable, however, in footnotes, 
parentheses, lists, tables, boxes and figures.

http://www.fao.org/faoterm
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Do not abbreviate the names of countries in text, e.g. exports to the United Kingdom of Great Britain 
and Northern Ireland, not ... to the UK; and exports to the United States of America, not ... to the 
USA (see Section 3.2 Names). In these two cases, however, acronyms may be used in references (see 
Section 10. Bibliographic style and references).

Do not begin a sentence with an abbreviation, initialism or acronym. FAO is an exception.
If you use numerous abbreviations or acronyms, list these in a separate section (Abbreviations and 
Acronyms) in the front matter (generally, after Acknowledgements), capitalizing proper nouns but not 
common nouns (e.g. GDP – gross domestic product, not Gross Domestic Product).

6. CAPITALIZATION
Avoid excessive use of capital letters in text. It is not usually necessary to capitalize common nouns 
(non-proper nouns). For example, rather than the Manager and 20 Officers, write the manager and 
20 officers.

Titles and headings have specific rules:

• In headings, subheadings, captions and book titles, use capitals only for the initial letter 
of the phrase and any proper nouns (names of persons, places, organizations, languages, 
nationalities). If the title is based on a conference/workshop whose title was capitalized, then the 
new title will need to retain the capitalization.

• Capitalize the initial letter of the first word and major words of series titles, including journal titles.

Capitals are used to distinguish the specific from the generic:

• Use capital letters when naming a specific body, e.g. The Government of France ruled that, but 
not in general references, e.g. All participating governments were asked to comment on the ruling.

• Organizations, committees, universities, laws, treaties, and so on take initial capitals when the 
full title is given. However, when used alone, the word organization takes a capital letter only 
when referring to FAO.

• Geographical and political designations, as well as official titles, take initial capitals for specific 
titles, but not when the term is generic.

• The word “state” takes a lower-case initial when referring generally to the institution or to nations 
or divisions of a nation; it takes a capital S when a specific state is named, e.g. State of Andhra 
Pradesh, but state-owned enterprise, head of state.

• Use initial capitals for historical eras and events (the First World War), declarations and 
conventions when the full title is given.

• Names of stars and planets (e.g. the Sun, the Earth, etc.) should be capitalized if treated as 
proper nouns. Where earth is used to refer to ground or soil, the word is not capitalized.

• Names of the seasons are not capitalized. Note that seasons should not generally be used to 
specify dates, as they vary according to the hemisphere, although exceptions may be made, 
e.g. for training materials aimed at a specific country/region. As a season, use autumn not fall.

• Initial capitals should be used for brand or trade names if the original is capitalized.
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6. CAPITALIZATION

For regions, capitalize when part of a proper name or political grouping, e.g. the representatives of 
Southeast Asia, the Near East and Eastern Europe, but not for a generic geographical grouping, e.g. a 
species common across eastern Europe.

Names of indigenous peoples and ethnic and national groups take an initial capital, and they are not 
italicized, e.g. the San people. 

Adjectives associated with these names are also capitalized. In proper nouns, use capital letters for 
all principal hyphenated words, e.g. European Commission for the Control of Foot-and-Mouth 
Disease. Do not capitalize, however, where a hyphen is part of a prefixed word. Note that 
sub-Saharan Africa does not take an initial capital. 

When referring to specific tabular or graphic elements in a text, use a capital letter for tables and figures, 
e.g. see Table 1.3. When referring to more than one tabular or graphic element, give each its full title: 
e.g. As shown in Figure 2 and Figure 3. Note that capitals are not used when the term is used in a 
general sense, e.g. see the table above.

The first word after a colon should be capitalized only if it is a proper noun or introduces a sentence.

7. ITALICS
Italic font is used for: 

• emphasis, as sparingly as possible (when the body text is in italic, roman type should be used for 
emphasis);

• all book and journal titles (titles of chapters and articles are not italicized); titles of paintings and 
sculptures; plays, films and radio and television programmes; and names of ships (prefixes such 
as SS or HMS are not italicized); 

• mathematical variables; 

• some foreign words and phrases use italics, others do not, for example: 

ITALICIZED NOT ITALICIZED

et al.
et seq.
ex ante
ex post
ex situ
in situ
in vitro
in vivo
inter alia
laissez-passer
per se
vis-à-vis

addendum

ad hoc

ad lib

de facto

e.g.

etc.

ibid.

i.e.

status quo

versus

vs

vice versa
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• the names of parties in legal cases: e.g. State of Wyoming v. Jameson;

• to indicate genera, species and subspecies. 

Do not italicize text between quotation marks, unless part of the original quotation.

8. NUMBERS, UNITS, TIME AND DATES

8.1 ___ NUMBERS
Always use Arabic numerals for dates, times, percentages, units of money or measurement, ages, page 
references, ratios and scales.

Numbers from one to ten inclusive are always written in text as words, whereas numbers 11 and 
upwards are written as numerals, with the following exceptions: 

• Spell out any number above ten that begins a sentence, e.g. Fifteen NGOs were present. 

• Use numerals where a number accompanies a unit, e.g. 5 cm, 7 percent, USD 2. 

• Use numerals when numbers from both groups are used consecutively, e.g. The number of 
replies varied, ranging between 2 and 12 per group.

For decimals:

• Use a point (a full stop, not a comma), e.g. 14.36.

• Use a zero before the decimal point for numbers smaller than 1, e.g. 0.23.

• Use the plural for any decimal number above 1.0, e.g. 1.5.

For large values:

• Use spaces, not full stops or commas, to denote thousands, etc. (e.g. 2 500; 10 000) in main 
text and tables. Use hard (non-breaking) spaces to avoid awkward number divisions at the end 
of lines (press CTRL+SHIFT+SPACEBAR, or ALT+SHIFT+SPACEBAR for Macintosh). Do not use 
spaces for years (e.g. 2007) or page numbers (e.g. p. 1402).

• For millions, use numerals separated by non-breaking spaces (e.g. 150 324 399) unless the last 
six numerals are zeroes, in which case express these digits as million (e.g. 150 000 000 should 
be written as 150 million). The same principle holds for billions, trillions, etc. Note: data are in 
general reported to three significant figures.

• FAO uses the short scale for billions and trillions: 1 billion = a thousand million or 
1 000 000 000 (109); 1 trillion = a million or 1 000 000 000 000 (1012), etc. Be aware 
of similar terms in other languages, such as milliard (109) used in French or millión (106) used 
in Spanish.

Write fractions in words rather than numbers: e.g. one-third.

Avoid the use of roman numerals except in established terminology (e.g. Type II error).
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8. NUMBERS, UNITS, TIME AND DATES

Where possible, write out ordinal numbers in full, e.g. the Thirteenth Session of the FAO Committee on 
Fisheries. Where it is necessary to use numerals, do not use superscript for the ordinal indicator, e.g. the 
13th Session not the 13th Session.

Avoid the use of adverbial ordinal numbers (firstly, secondly, thirdly, etc.), as subsequent numbers 
sound awkward. Replace these with first, second, third, etc.

For telephone and fax numbers, be consistent in the use of parentheses or spaces. The recommended 
style is: (+39) 06 57057051.

To refer to a specific page: p. 40. To refer to a range: pp. 40–42. To refer to the total number of pages 
in a publication: 120 pp.

8.2 ___ UNITS
Use the International System of Units (SI) – tonnes, hectares, etc., with equivalents in parentheses 
if necessary.

Do not use punctuation or letter spacing in such measurements as cm, mm, g, ha, °C. Note, however, 
that there should always be a non-breaking space between the number and the unit, e.g. 3 cm, 70 g, 
37 °C. 

Do not use the plural for symbols/abbreviations of units (e.g. 7 kg, not 7 kgs).

To indicate “per”, use / as in 3 m/s (rather than 3 m s-1).

Avoid combinations of three units of the type: Production is 25 tonnes/ha/year. Prefer: Annual production 
is 25 tonnes/ha.

Do not abbreviate the words litre and tonne. In general, use tonnes, not tons or metric tonnes. Check 
with originators if unsure whether they mean tons (imperial) or tonnes (metric). For shipping, use tons. 

Always give temperature in Celsius not Fahrenheit, e.g. 35.5 °C.

In series of units, consistently use the symbol: 10 cm, 20 cm and 50 cm, not 10, 20 and 50 cm.

8.3 ___ PERCENTAGES
Use percent (never per cent) rather than the symbol “%”in text, e.g. Exports increased by 16 percent 
in the last quarter. In tables and figures, use the symbol with no space between the number and the 
symbol, e.g. 16%.

8.4 ___ DATES
Write dates in this order: Monday, 16 October 2000 (with no comma between the month and the year).

Do not use ordinal numbers such as 3rd, 4th, 5th for dates (e.g. 1 January, not 1st January).

Avoid starting a sentence with a year (or other figure), but if unavoidable it must be spelled out: 
Nineteen ninety-eight was not a leap year.

Do not use apostrophes in decades: e.g. 1990s. 
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Do not abbreviate years, i.e. use 1990, not ’90. Decades are referred to in numerals (e.g. the 1990s, not 
the nineties and not the 90s).

A range of dates is normally indicated thus: e.g. 2015–2025 or from 2015 to 2025. This implies the 
whole period from the beginning of 2015 to the end of 2025 inclusive, whereas 2015/16 implies one 
crop or fiscal year of 12 months starting in 2015 and ending in 2016. Note that, when used in tables, 
three-year averages may take a hyphen to denote the three-year period and an en-dash between the two 
sets, e.g. 1997-99–2015-16.

Centuries should be written out in full, e.g. the twenty-first century not the 21st century.

Where necessary to avoid confusion, use BCE (before Common Era) or CE (Common Era) for dates, 
placing the abbreviation after the year (e.g. 1000 BCE).

8.5 ___ TIME
The use of the 24-hour system is preferred, e.g. 08.00 hours, 13.30 hours. When it is necessary to use 
the 12-hour system, use full stops as follows: e.g. 8 a.m., 1.30 p.m. Be consistent.

Use a non-breaking space between the number and the unit (press CTRL+SHIFT+SPACEBAR, or 
ALT+SHIFT+SPACEBAR for Macintosh).

8.6 ___ CURRENCIES
Rather than the currency symbol (which sometimes fails to convert in other software programs), use the 
ISO Currency Code as given in NOCS, with a non-breaking space between the abbreviation and the 
amount, e.g. USD 700 000 rather than US$700,000 and EUR 800 000 rather than €800,000. 

To facilitate comparison of amounts in different currencies within a text, try to give an indicative equivalent 
in USD, or provide an exchange rate (either in a footnote or at the end of the list of abbreviations and 
acronyms). The exchange rate equivalent should be that valid at the date of the values rather than the 
current one.

8.7 ___ MATHEMATICS AND EQUATIONS
Relational and operational signs should have a space either side of them (e.g. 3 + 2 = 5).

Use the multiplication sign × (found in Word under Insert – Symbol) not lower-case letter x.

Use Word Equation Editor to set out equations. 

Symbols used for variables, including Greek characters, should be italicized.

In chemical formulae, use subscript (indicating molecules), reduced font below the line: CO2. Only use 
CO2 where it is impossible to use a subscript. (Superscript indicates atomic charge, as in Ba2+.)
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9. QUOTATIONS
Use Harvard style.

For words or short sentences, use quotation marks:
McKinsey and Company (2009) state that “in forestry and agriculture, both costs and 
investments are relatively low.”

Use double quotation marks for the whole quote, and single quotation marks for a quote or highlight within 
the main quote. For examples, Baresi (1998) reports that “farmers complain about ‘unofficial’ agents.”

For paragraphs (or any text of more than 30 words or two lines), use block quotations. These are 
introduced by a colon and indented in the following line, set in a smaller font size to differentiate them 
from main text. 

As stated in the document:
Ensuring food security and nutrition at the household and global levels, requires invest-
ing in nutrition-sensitive agriculture, protecting women’s rights and improving their 
social and nutritional status (FAO, 2011, p. 3).

10. CITATIONS AND REFERENCING STYLE IN FAO 
PUBLICATIONS 

10.1 __ GENERAL INDICATIONS
In the front matter (usually on the same page as the Abstract, sometimes on the Disclaimer page, 
sometimes on the back cover), all books produced by FAO should include their proper citation – author, 
year, full title and subtitle (in italics), series, place of publication, publisher and number of pages (total 
including preliminary pages). It is not necessary to provide such a citation on non-book products.

Many FAO publications will have FAO as the author. However, depending on the category of publication 
and in line with the indications of the FAO Corporate Publishing Policy and Publishing at FAO – Strategy 
and Guidance, authorship of the publication may be attributed to FAO or to individual authors, as is the 
case with many regular and high-profile publications.

For in-text references, FAO uses an author–date style – name of author followed by year of publication 
of the work cited, e.g. Costa and Gilles, 2016. To insert in-text references, originators can also use the 
online FAO bibliographic style in Citation Style Language (CSL) for use with Mendeley and Zotero (see 
Section 10.2 Reference lists and bibliographies).

It is not necessary to indicate the page number(s) unless the text is quoted.

Avoid the use of abbreviations such as op. cit., loc., cit., ibid., cf. in footnotes or endnotes. Any such 
information should be converted to full entries in the References or Bibliography section and the 
appropriate footnote marker replaced with an entry, e.g. Smith, 1997. 
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Do not use the ampersand character (&) for in-text references, so not Jackson & Schmidt but Jackson 
and Schmidt.

Where there are more than three authors, abbreviate to et al. for the in-text reference, e.g. Walls et al., 
2009). See also Section 10.2 Reference lists and bibliographies for guidance on citation of authors’ 
names in reference lists.

In-text references should be presented as follows:

• one work, one author:
... as demonstrated by Sanders (2008) ...
... as it has been demonstrated (Sanders, 2008) ...

• one work, up to three authors:
... according to a recent report (Sanders, Cohen and Bolbol, 2010) ...

• one work, more than three authors:
... as stated in a recent survey (Sanders et al., 2011) ... 

• more than one work by different authors:
... as various studies demonstrate (Sanders, 2008; Murguía, 2010) ...
... as various studies demonstrate (Sanders, 2008; Murguía, 2010; Bekele et al., 2007) ...

• more than one work by the same author:
(Sanders, 2009a, 2009b)

• different authors with the same surname:
(Sanders, J., 2009; Sanders, B., 1999)

• edited works:
(Sanders, ed., 2008)
according to Sanders (ed., 2008)

• indirect reference (secondary source); when referring to a source cited within another source, 
refer to the one you consulted, not the original:
as demonstrated by Sanders (cited in Murguía, 2008).

Note that personal communications are not cited in the bibliography, only in the text, e.g. (J. Wright, 
personal communication, 2000).

For works published by FAO, check the title page for authors’ names. Any named authors can be cited as 
such. If there are no named authors, it is a corporate work and FAO should be cited as the author. For more 
on whether to attribute publications to individual authors or FAO, see Publishing at FAO Section 1.11.

10.2 __ REFERENCE LISTS AND BIBLIOGRAPHIES

Citations

Many FAO publications include in-text references with a section called References or Bibliography 
listing all works cited. This section is placed at the end of the main text (and before the annexes). 
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Proper referencing is important for the credibility of FAO publications and for avoiding accusations of 
plagiarism. It is a standard part of originators’ work. However, attempting to comply with style-guide 
recommendations on citations can be difficult and time-consuming.

Points to note

A references section contains all the works cited in the main text. A bibliography may also contain 
separate additional material used for the writing of the publication, but not directly cited in the text, as 
well as further reading.

Aim for consistency in the presentation of entries. 

All references must be “complete” in the sense that they include at least the minimum information needed 
to specify the work in question. Typically, for a book, this means as a minimum: name of author(s), year 
of publication, title, place of publication, publisher and number of pages (including preliminary pages 
in the total); for an article in a journal: name of author(s), year of publication, title, journal title, volume, 
issue and pages.

For all reference entries:

• In the case of multiple authors, the names of all authors should usually be given. If the list 
of authors is unmanageably long, cite only the main authors, followed by et al. FAO follows 
Chicago style: 
For works by or edited by four to ten persons, all names are usually given in the bibliography. … For works with 
more than ten authors … only the first seven should be listed in the bibliography, followed by et al.

• Use the ampersand (&) between the names of the last two authors in the bibliography, but use 
and in the text.

• Entries by the same author/s should be listed in ascending chronological order. Where there 
are two or more titles by the same author in the same year, distinguish by using a, b, c, etc. as 
necessary after the year. The lettering is determined by the order in which the works are first cited 
in the text, the first work mentioned being assigned the letter a, e.g. 2008a.

• Titles of books, journals and periodicals are italicized (do not use inverted commas). Titles of 
articles and chapters are not italicized. 

• Bold should only be used for authors but not for any other element of the reference, Munro. G.R. 
2010. From drain to …

• The place (city) of publication comes before the publisher, e.g. Ankara, FAO. When the city is 
the capital, the country is normally omitted. In reference entries, the United States and United 
Kingdom may be abbreviated to USA and UK. Omit other geographical or administrative 
details, i.e. no county/state/province.

• Forthcoming publications, i.e. works that have not yet been published at the time of writing, 
should be cited as forthcoming, not in press or in preparation. Thus:

 _ in the text: (Brandt, forthcoming)

 _ in the References/Bibliography: Brandt, S. (forthcoming). Title …

10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS
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• For all publications where FAO is the author or publisher (with the publication attributed to 
individual authors, always provide the URL (preferably the short URL). This aids dissemination of 
FAO publications.

• For references in a different language, refer to the FAOSTYLE for that language.

• Articles in journals. In a References/Bibliography, choose either to give the full titles of the 
journals or their abbreviated titles in all entries, not some full and some abbreviated. Abbreviated 
titles should be in the form of the standard “approved” abbreviation for the journals. There are 
various lists of such journal abbreviations available online, generally grouped by sector.

Styles, and limitations of the FAO citation style

For publications in English, there is no one global standard style for composing and formatting reference 
entries. A number of different styles are in use in different sectors of the publishing world, e.g. APA, 
Chicago, Harvard and MLA. Over the years, like many other organizations, FAO has developed its 
own bibliographic style. However, this style is different from widely accepted styles, and hence many 
originators and editors have difficulty in applying it correctly. This has meant FAO has spent a significant 
amount of time and money on generating, formatting and correcting reference entries. Moreover, the FAO 
bibliographic style, developed in the age of the typewriter and word processor, does not facilitate the use 
of today’s standard reference management software.

Manual generation and formatting of citations

If you intend to input reference entries manually, please refer to the tables in Section 10.3 Examples of 
bibliographic style for examples of how to cite FAO and non-FAO publications.

New option – automatic generation of citations and references/bibliographies

Several bibliographic management software programs facilitate the generation of citations and 
bibliographic entries, e.g. EndNote, Mendeley, RefWorks and Zotero. Such tools (some open-source) 
save time and remove much of the drudgery from formatting citations and generating bibliographies. 

There is now available online an FAO bibliographic style in Citation Style Language (CSL)2 for use with 
Mendeley and Zotero. For guidance on how to install these, please see Annex 1. 

As there are various video tutorials available online, even complete beginners can start using these 
tools within a few minutes to input records manually (completing standard fields such as author, title, 
year) or automatically (e.g. using metadata from web pages and PDFs). These records can then be 
downloaded as necessary in the form of reference entries already formatted in FAO bibliographic style. 
The records will then remain in a master file (or can be grouped in appropriate subfolders) for use in 
future publications. They can also be exported and shared with other colleagues. In this way, a unit can 
compile a large master file of citation entries that can be accessed by all users.

In some minor cases, it has been necessary to adapt the FAO bibliographic style to fit the software (e.g. 
the way URLs are cited). The tables in Section 10.3 Examples of bibliographic style indicate which item 
type should be selected in Mendeley and Zotero.

2  OCCP is especially grateful to Liu Bin, Nutrition Officer (ES), for creating, testing and amending the CSL version of the FAO citation style.
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Please remember that although software tools can capture almost all of the elements required for citations, 
it may be necessary to make some manual edits. For a type of item not specified in the list, select the 
type that is most similar and edit as necessary. Moreover, the item types and outputs from Mendeley and 
Zotero are not identical. 

In addition, the FAO Library has licensing arrangements for EndNote, with FAOSTYLE citations. If you 
prefer to use EndNote, please contact the FAO Library.

10.3 __ EXAMPLES OF BIBLIOGRAPHIC STYLE
Table 1. Citation examples for FAO publications and electronic resources

FAO PUBLICATIONS – 
TEMPLATE

ITEM TYPE

ZOTERO MENDELEY

FAO as author Corporate Author. Year of publication. Publication title. Series. 
Place of publication. Number of pages (total including preliminary 
pages). (URL [short if available]).

Other author of FAO 
publication 

Personal Author. Year of publication. Publication title. Series. 
Place of publication. Publisher. Number of pages (total including 
preliminary pages). (URL [short if available]).

FAO PUBLICATIONS – 
EXAMPLES

Where FAO is a co-author FAO, IFAD & WFP. 2015. The State of Food Insecurity in the 
World 2015. Meeting the 2015 international hunger targets: 
taking stock of uneven progress. Rome, FAO. 56 pp. (also 
available at www.fao.org/3/a-i4646e.pdf).

Book Book

Single author Munro, G.R. 2010. From drain to gain in capture fisheries 
rents: a synthesis study. FAO Fisheries and Aquaculture Technical 
Paper No. 528. Rome, FAO. 49 pp. (also available at www.fao.
org/3/a-i1617e.pdf).

Book Book 
(no series number 

field; put whole 

string in Series 

field)

2 or 3 authors Mrema, G., Soni, P. & Rolle, R.S. 2014. A regional 
strategy for sustainable agricultural mechanization. Sustainable 
mechanization across agri-food chains in Asia and the Pacific. 
Bangkok, FAO. 92 pp. (also available at www.fao.org/3/a-
i4270e.pdf).

Book Book

More than 3 authors Marzin, J., Bonnet, P., Bessaoud, O. & Ton-Nu, C. 2017. 
Study on small-scale family farming in the Near East and North 
Africa region. Synthesis. Cairo, FAO, CIRAD & CIHEAM. 186 pp. 
(also available at www.fao.org/3/b-i6436e.pdf).

Book Book

Editors Bartley, D.M. & Leber, K.M., eds. 2004. Marine ranching. 
FAO Fisheries Technical Paper No. 429. Rome, FAO. 213 pp. 
(also available at ftp://ftp.fao.org/docrep/fao/008/y4783e/
y4783e00.pdf).

Book Book

Forthcoming, undated and 
the like

FAO. forthcoming. The State of Food and Agriculture 2017. 
Rome.

Book 
(Put whole 

forthcoming in 

Data field)

Book 
(Put whole 

forthcoming in 

Data field)

10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS
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FAO PUBLICATIONS – 
TEMPLATE

ITEM TYPE

ZOTERO MENDELEY

Author with more than one 
work in the same year, add 
letters (a, b, c) after year, 
with first work mentioned in 
the main text appearing as 
YYYYa.

FAO. 2003a. Fisheries management. 2, The ecosystem approach 
to fisheries. FAO Technical Guidelines for Responsible Fisheries 
No. 4, Suppl. 2. Rome. 112 pp. (also available at ftp://ftp.fao.
org/docrep/fao/005/y4470e/y4470e00.pdf).  
FAO. 2003b. The State of World Fisheries and Aquaculture 
2002. Rome. 150 pp. (also available at ftp://ftp.fao.org/
docrep/fao/005/y7300e/y7300e.pdf).

Book Book

Book section (e.g. chapter) Braatz, S. 2012. Building resilience for adaptation to climate 
change through sustainable forest management. In A. Meybeck, 
J. Lankoski, S. Redfern, N. Azzu & V. Gitz, eds. Building resilience 
for adaptation to climate change in the agriculture sector. 
Proceedings of a joint FAO/OECD Workshop, pp. 117–127. 
Rome, FAO. (also available at www.fao.org/docrep/017/
i3084e/i3084e09.pdf). 

Book section Book section

Where FAO is a copublisher Kuhlein, H.V., Erasmus, B. & Spigelski, D. 2009. 
Indigenous peoples’ food systems: the many dimensions of culture, 
diversity and environment for nutrition and health. Rome, FAO, 
and Quebec, Canada, Centre for Indigenous Peoples’ Nutrition 
and Environment (CINE). 349 pp. (also available at ftp://ftp.fao.
org/docrep/fao/012/i0370e/i0370e00.pdf).

Book Book

Article in FAO journal (or 
newsletter)

Garavaglia, V. & Besacier, C. 2014. The state of 
Mediterranean forests in 2013. Unasylva, 242: 3–13. (also 
available at www.fao.org/3/a-i3837e.pdf).

Journal 
article

Journal 
article

FAO fact sheet FAO. 2016. Dominican Republic – country fact sheet on food and 
agriculture policy trends. Rome. 6 pp. (also available at www.fao.
org/3/a-i5814e.pdf).

Book Book

Other print items 
(meeting papers, poster 
presentations, internal 
documents, unpublished 
material, etc.)

FAO. 2007. Final report of the project OSRO/AFG/408/
GER “Provision of storage facilities and equipment to vulnerable 
households and rural communities in Afghanistan”. FAO internal 
document. Rome.

Manuscript Generic 
(put FAO internal 

document” in 

Publisher field)

ELECTRONIC  
RESOURCES – TEMPLATE

Website Corporate Author. Year of publication. Website identity 
[online]. Physical site location (if known; usually Rome). [Citation 
date]. Website link.

Web page or fact sheet Corporate Author. Year of publication. Web page title (Cover 
page + Page title). Text by Personal Author. In: Website Identity 
[online]. Physical site location. [Citation date]. Web page link.

PDF Corporate Author. Year of publication. Document title [online]. 
Document series. [Citation date]. Link to PDF.

Database Corporate Author. Reference year. Database title (Cover page 
+ Page title). In: Website identity [online]. Physical site location. 
Updated as at. [Citation date]. Web page link.

FAO ELECTRONIC  
RESOURCES – EXAMPLES

Website FAO. 2017. Food and Agriculture Organization of the United 
Nations [online]. Rome. [Cited 15 February 2017]. www.fao.org/
home/en/

Web page Web page

Web page FAO. 2011. Geographic Information – Introduction. In: FAO 
Fisheries and Aquaculture Department [online]. Rome. [Cited 
15 February 2017]. www.fao.org/fishery/geoinfo/en

Web page Web page
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FAO PUBLICATIONS – 
EXAMPLES

ITEM TYPE

ZOTERO MENDELEY

Web fact sheet FAO. 2011. National Aquaculture Sector Overview. Albania. 
National Aquaculture Sector Overview Fact Sheets. Text by 
Cobani, M. In: FAO Fisheries and Aquaculture Department 
[online]. Rome. Updated 9 November 2010. [Cited 15 February 
2017]. www.fao.org/fishery/countrysector/naso_albania/en

Web page Web page

Monograph (PDF) only 
available on Web

FAO. 2008. Technical guidelines on aquaculture certification 
[online]. Committee on Fisheries. Fourth Session of the Sub-
Committee on Aquaculture, Puerto Varas, Chile, 6–10 October 
2008. COFI/AQ/IV/2008/Inf.7. [Cited 15 February 2017]. 
ftp://ftp.fao.org/docrep/fao/meeting/014/ai770e.pdf

Web page Web page

Database FAO. 2017. FAOSTAT. In: FAO Fisheries and Aquaculture 
Department [online]. Rome. [Cited 15 February 2017]. www.fao.
org/faostat/en/#home 
FAO. 2017. Fishery and Aquaculture Statistics. Global Production 
Statistics 1950-2014 (query panel). In: FAO Fisheries and 
Aquaculture Department [online]. Rome. Updated 2017. [Cited 
15 February 2017]. www.fao.org/fishery/statistics/global-
production/query/en

Web page Web page

Audio, CD–ROM, DVD, 
video, e-book

FAO. 2017. Global Forum for Food and Agriculture 2017 
[audio]. Rome. [Cited 15 February 2017]. www.fao.org/news/
audio-video/detail-audio/en/?dyna_fef[uid]=12012&uid=12012

Audio 
recording 
(for audio/video 

file types, put 

audio/video in 

Format field)

Generic 
(put audio in 

Genre field)

FAO. 2006. Setting up and running a school garden: a manual 
for teachers, parents and communities [CD–ROM]. Rome.

Computer 
program 
(put CD–ROM in 

System field)

Computer 
program 
(put CD–ROM in 

Genre field)

FAO. 2017. PPR kills endangered Mongolian antelope for the 
first time [video]. [Cited 15 February 2017]. www.fao.org/news/
audio-video/detail-video/en/?dyna_fef[uid]=12032&uid=12032

Video 
recording 
(for audio/video 

file types, put 

audio/video in 

Format field)

Film 
(put video in 

Genre field)

FAO. 2016. State of food insecurity in the Central African 
Republic [video]. [Cited 15 February 2017]. https://www.
youtube.com/watch?v=sZUTJIz8DsE 

Video 
recording

Film

FAO. 2016. The State of Food and Agriculture 2016. Climate 
change, agriculture and food security [Kindle edition]. Rome.

Book 
(put “genre: Kindle 

edition” in Extra 

field)

Book 
(put “Kindle 

edition” in Genre 

field)

10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS
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Table 2. Citation examples for non-FAO publications and electronic resources

NON-FAO 
PUBLICATIONS – 
EXAMPLES

ITEM TYPE

ZOTERO MENDELEY

Single author named within 
text

Chambers, R. 2005. Ideas for development. London, Earthscan. Book Book

2 or 3 authors Graham, J., Amos, B. & Plumptre, T. 2003. Principles 
for good governance in the 21st Century. Policy Brief No. 15. 
Ottawa, Institute on Governance.

Book Book

More than 3 authors Delgado, C.L., Wada, N., Rosegrant, M.W., Meijer, S. 
& Mahfuzuddin, A. 2003. Fish to 2020: supply and demand 
in changing global markets. Technical Report 62. Washington, 
DC, International Food Policy Research Institute, and Penang, 
Malaysia, WorldFish Center.

Book Book

Editors Curtis, R. & Squires, D., eds. 2007. Fisheries buybacks. 
Oxford, UK, Blackwell. 

Book Book

Corporate author World Trade Organization. 2016. World Trade Report 2016: 
Levelling the trading field for SMEs. Geneva, Switzerland. (also 
available at www.wto.org/english/res_e/booksp_e/world_trade_
report16_e.pdf).

Book Book 
(set name as 

institution/ 

organization)

Corporate author where 
initialism is used in in-text 
reference

International Telecommunication Union (ITU). 2010. 
Measuring the information society 2010. Geneva, Switzerland.

Book Book

Author with more than one 
work in the same year, add 
letters (a, b, c) after year, 
with first work mentioned in 
the main text appearing as 
YYYYa.

World Bank. 2010a. World Development Report 2010. 
Development and climate change. Washington, DC.
World Bank. 2010b. Economics of adaptation to climate 
change. Synthesis report. Washington, DC.
World Bank. 2010c. Vietnam: economics of adaptation to 
climate change. Washington, DC.

Book Book

List publications by no. of 
authors: Author A, A+B, 
A+B+C, A+B+C+D

Béné, C. & Neiland, A. 2006. From participation to 
governance: a critical review of the concepts of governance, 
comanagement and participation, and their implementation in 
small-scale inland fisheries in developing countries. WorldFish 
Center Studies and Reviews No. 29. Penang, Malaysia, The 
WorldFish Center, and Colombo, CGIAR Challenge Program on 
Water and Food. 
Béné, C., Macfadyen, G. & Allison, E.H. 2007. Increasing 
the contribution of small-scale fisheries to poverty alleviation and 
food security. FAO Fisheries Technical Paper No. 481. Rome, 
FAO. 125 pp. (also available at ftp://ftp.fao.org/docrep/
fao/009/a0965e/a0965e00.pdf).

Book Book

Book section (e.g. chapter) Adger, W.M., Agrawala, S., Mirza, M.M.Q., Conde, 
C., O’Brien, K., Pulhin, J., Pulwarty, R., Smit, B. & 
Takahashi, K. 2007. Assessment of adaptation practices, 
options, constraints and capacity. In M.L. Parry, O.F. Canziani, J.P. 
Palutikof, C.E. Hansan & P.J. van der Linden, eds. Climate change 
2007: impacts, adaptation and vulnerability, pp. 719–743. 
Contribution of Working Group II to the Fourth Assessment Report 
of the Intergovernmental Panel on Climate Change. Cambridge, 
UK, Cambridge University Press.

Book section 
(put “Contribution 

of …” in Series 

field)

Book section 
(put “Contribution 

of …” in Series 

field)

Article in journal Allison, E. & McBride, R. 2003. Education reform for 
improved natural resource management: fisheries and aquaculture 
in Bangladeshi Universities. Society and Natural Resources, 16(3): 
249–263.

Journal 
article

Journal 
article
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NON-FAO 
PUBLICATIONS – 
EXAMPLES

ITEM TYPE

ZOTERO MENDELEY

Newspaper article Glanz, J. & Armendariz, A. 2017. Years of Ethics Charges, 
but Star Cancer Researcher Gets a Pass. The New York Times, 
8 March 2017. (also available at https://www.nytimes.
com/2017/03/08/science/cancer-carlo-croce.html).

Newspaper 
article

Newspaper 
article

Thesis/dissertation Arnason, R. 1984. Efficient harvesting of fish stocks: the case 
of the Icelandic demersal fisheries. Department of Economics, 
University of British Columbia. (PhD dissertation)

Thesis 
(put “Department 

…” in Place field)

Thesis 
(put “Department 

…” in City field)

Other print items 
(meeting papers, poster 
presentations, internal 
documents, unpublished 
material, etc.)

Tung, D.X. 2005. Smallholder poultry production in Vietnam: 
marketing characteristics and strategies. Paper presented at the 
workshop “Does Poultry Reduce Poverty? A Need for Rethinking 
the Approaches”, 30–31 August 2005, Copenhagen, Network for 
Smallholder Poultry Development.

Confer-ence 
paper

Confer-ence 
proceed-ings 
(cannot be 

generated 

perfectly)

Fontana, M. & Natali, L. 2008. Gendered patterns of time 
use in Tanzania: public investment in infrastructure can help. Paper 
prepared for the IFPRI Project “Evaluating the Long-Term Impact of 
Gender-focused Policy Interventions” (unpublished).

Manuscript Generic 
(put all text after 

year in Title field)

Legal cases (APA style) Name v Name, Volume Source Page (Court Date)
Lessard v Schmidt, 349 F. Supp. 1078 (E.D. Wis. 1972)
Blystone v Pennsylvania, 494 U.S. (1990)
People v Armour, 590 N.W.2d 61 (Mich. 1999)

Case Case

NON-FAO ELECTRONIC 
RESOURCES

Website International Maritime Organization (IMO). 2017. IMO 
[online]. London. [Cited 15 February 2017]. www.imo.org/en/
Pages/Default.aspx

Webpage 
(put “London” in 

Extra field)

Webpage 
(put “London” in 

Notes field)

Web page World Bank. 2017. History. In: The World Bank [online]. 
Washington, DC. [Cited 15 February 2017]. www.worldbank.
org/en/about/history

Webpage Webpage

Monograph (PDF) only 
available on Web

World Bank. 2006. Where is the wealth of nations? 
Measuring capital for the 21st century [online]. Washington, 
DC. [Cited 15 February 2017]. siteresources.worldbank.org/
INTEEI/214578-1110886258964/20748034/All.pdf

Webpage Webpage

Part of Website/monograph Economic and Social Commission for Asia and the 
Pacific (ESCAP). 2009. What is good governance? [online]. 
[Cited 15 February 2017]. www.unescap.org/pdd/prs/
ProjectActivities/Ongoing/gg/governance.asp

Webpage Webpage

Article in e-journal (DOI or 
URL)

Agnew, D.J., Pearce, J., Pramod, G., Peatman, T., 
Watson, R., Beddington, J.R. & Pitcher, T.J. 2009. 
Estimating the worldwide extent of illegal fishing. PLoS ONE, 
4(2): e4570 [online]. [Cited 15 February 2017]. https://doi.
org/10.1371/journal.pone.0004570

Magazine 
article

Magazine 
article
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NON-FAO 
PUBLICATIONS – 
EXAMPLES

ITEM TYPE

ZOTERO MENDELEY

Audio, CD–ROM, DVD, 
video

International Labour Organization (ILO). 2016. The 
African entrepreneur using technology to boost access to public 
health [audio]. [Cited 15 February 2017]. www.ilo.org/global/
about-the-ilo/multimedia/audio/WCMS_523716/lang--en/index.
htm

Audio 
recording 
(for audio/video 

file types, put 

audio/video in 

Format field)

Generic

Giel, T., Bijman, J. & Oorthuizen, J. 2007. Producer 
organisations and market chains [CD–ROM]. Wageningen, 
Netherlands, Agri-Profocus.

Computer 
program 
(put CD–ROM 

in System field; 

put publisher in 

Company field)

Computer 
program 
(put CD–ROM 

in Genre field; 

put publisher in 

Publisher field)

World Bank. 2017. RISE – Regulatory Indicators for Sustainable 
Energy [video]. [Cited 15 February 2017]. www.worldbank.org/
en/news/video/2017/02/15/rise---regulatory-indicators-for-
sustainable-energy

Video 
recording 
(for audio/video 

file types, put 

audio/video in 

Format field)

Film

World Health Organization (WHO). 2017. Rehabilitation: 
Key for health in the 21st century [video]. [Cited 15 February 
2017]. https://www.youtube.com/watch?v=a8uaRziXruc

Video 
recording 
(for audio/video 

file types, put 

audio/video in 

Format field)

Film
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ANNEX 1 
INSTALLING REFERENCE MANAGEMENT SOFTWARE  
FOR CITATIONS IN FAO STYLE 
All operations described in this annex can be done with normal user rights. No administrator-user rights 
are required.

_______ HOW TO INSTALL MENDELEY AND ZOTERO1

To install Zotero or Mendeley:

1. Open FAO Application Catalog in Internet Explorer. Other browsers are not supported.  
(If unable to access, download programs from their respective home pages.)

2. Input “Zotero” or “Mendeley” in the search bar in upper right corner. Press Enter.

3. Press the blue “INSTALL” button at lower right part. In the pop-up window, select “YES”.

4. After a while, the software will be installed to the computer. It can be found in Start menu → All Programs.

Note: First-time running of Mendeley requires registration and log in.
To use Zotero and Mendeley to format citations automatically, you also need to install the Word add-in 
and browser connector. Complete the following steps using Google Chrome.

— For Zotero

• Word add-in:

1. Make sure Word is closed. From Zotero’s menu: Tools → Preferences.

2. Click “Cite” button. Choose “Word Processors” tab.

3. Click “Install Microsoft Word Add-in” button. After a few seconds, a window will pop out showing 
“Installation was successful.”

4. To confirm, open Word. A new “ZOTERO” tab should appear in the ribbon.

• Connector for Chrome:

1. Open this link using Google Chrome.

2. Click the blue “ADD TO CHROME” button.

3. Click “Add Extension” button in the pop-out window.

In Word, Zotero appears as a tab between View and Add-ins.

— For Mendeley

• Word add-in:

1. Make sure Word and Outlook are closed.  
From Mendeley’s menu: Tools → Install MS Word Plugin.

2. A window will pop out showing that the installation is successful and how to check in Word.

1 The mention of specific companies or products of manufacturers, whether or not these have been patented, does not imply that these have 
been endorsed or recommended by FAO in preference to others of a similar nature that are not mentioned.

https://chrome.google.com/webstore/detail/zotero-connector/ekhagklcjbdpajgpjgmbionohlpdbjgc
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• Connector for Chrome:

1. From the menu: Tools → Install Web Importer.

2. A web page will appear in browser. Follow the instructions. It’s similar to Zotero.

In Word, Mendeley appears under the References tab as Insert Citation.

_______ HOW TO INSTALL FAO CITATION STYLE FOR MENDELEY AND ZOTERO
Prerequisite: Install Zotero or Mendeley as indicated above.

— In Zotero
1. From the Zotero menu: Tools → Preferences.
2. Click “Cite” button. Choose “Styles” tab.
3. Click “Get additional styles…” link on bottom left of the “Style Manager” frame. It will take you to 

the Zotero Style Repository.
4. Input “fao” in the search bar.
5. Click the link “Food and Agriculture Organization of the United Nations” to download the style file 

(.csl). If the link is covered by the preview of the style, just click the first word “Food”.
6. Save the file to hard drive.
7. Go back to Zotero’s Preferences window. Click the “+” button on bottom right of the “Style 

Manager” frame.
8. Navigate to the folder where the style file is stored and choose the “food-and-agriculture-

organization-of-the-united-nations.csl” file. Click Open to install it.
9. “Food and Agriculture Organization of the United Nations” should appear in Style Manager.

— In Mendeley
1. From the Mendeley menu: View → Citation Style → More Styles…
2. Choose “Get More Styles” tab. 
3. Input “food and” in the search bar. “Food and Agriculture Organization of the United Nations” 

should appear.
4. Select the style. Click “Install” button on the right.
5. “Food and Agriculture Organization of the United Nations” should appear in the “Installed” tab.

_______ HELP GUIDES AND VIDEO TUTORIALS
For both Zotero and Mendeley, various help guides and video tutorials are available online. For example:

• Zotero: 
https://www.zotero.org/support/screencast_tutorials 
https://www.zotero.org/support/screencast_tutorials/zotero_and_word

• Mendeley:  
https://www.mendeley.com/guides/desktop 
https://www.mendeley.com/guides

https://www.zotero.org/styles/
https://www.zotero.org/support/screencast_tutorials
https://www.zotero.org/support/screencast_tutorials/zotero_and_word
https://www.mendeley.com/guides/desktop
https://www.mendeley.com/guides
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OCCP CONTACTS

Publishing policy and procedures 
PWS-support@fao.org

Copyright, rights, licensing, FAO logo clearance 
Copyright@fao.org

Clearance/requests letter of agreement (LoA) / 
memorandum of understanding (MoU) copyright clause  
occp-clearance@fao.org

Marketing, dissemination and sales  
Publications-Sales@fao.org  
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